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CloseBrowser Skills
Checklist
No matter what web browser you use, you will need
to know these basic skills.

Note: All instructions are for Internet Explorer v.4

ë Identify and open a hyperlink
A “real life” example of a link: when a
newspaper or journal sends you from one page
to another.
Click on the highlighted or blue text.  Or click on
parts of the screen where the mouse turns to a hand.

ë Go to a specific Web Address
Click in Location and enter a new URL.  
Or Click the File button on the toolbar, select Open, and enter the URL.

Note: URL stands for Uniform Resource Locator and is synonymous with the web site address. A URL
can give much useful information.

http://www.remc11.k12.mi.us/bcisd/classres/index.htm 

In the example above, http:// shows the protocol or the type of connection to the site.  Others could be
ftp:// or gopher:// or file:// or https://
https:// tells you that the site is a secure server.

www.remc11.k12.mi.us  is the domain name or Internet address of the computer or server you are
connecting to.  This can give you useful information as well.  For example, we can see that this
computer is in Michigan in the United States. Guess what these endings mean:

org com gov
net edu ca
au nz jp

bcisd/classres are folders or directories on the computer.
index.htm is the name of the web page or file.

ë Go backward and forward through the pages you’ve visited
Use the back and forward buttons.
Or, click on the down arrow beside the back button to jump back several pages.
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ë Interrupt a page download
Click on the Stop button on the toolbar to stop a page download.  Sometimes when you are  downloading
information such as large graphics, it will take a lot of time.  This is especially at peak usage of the
Internet between 11am and 5 or 6 pm.  Here are some ways to know if your computer is still working:

1. The Netscape or Explorer picture (upper right) is moving.
2. The status bar changes, telling you how much info has come in.

PC: If the system has locked up, press Ctrl+Alt+Del and press Enter to close Explorer.  If this doesn't
work, press Ctrl+Alt+Del again to completely restart your computer.  

MAC: Press Ctrl+Apple+the power button on the keyboard to restart your computer.

ë Print a web page
Click on the print button on the toolbar.

ë Add a bookmark or a favorite
Click on Favorites, Add a Favorite.  Click on Favorites again to see it.

ë Organize bookmarks
Click on Favorites, Organize Favorites.

To delete favorites, click on the favorite, press the Delete key on your keyboard.
To add a folder, click on the New Folder icon on the toolbar. Name the folder and drag the favorites

you want into the folder.
Click Close when you are finished.

Advanced Browser Skills

ë Troubleshooting: What to do when a page doesn’t work
Check to see if it is typed exactly.
There shouldn’t be any spaces. If it looks like the address should have a space, it is probably

the underscore “_”.
Usually the addresses are all lowercase (but check for capitalizations).

ë Modify the URL to find missing pages and find out the author/origin/ of a page
Click twice in the Location box.  Delete parts of the URL (to the slash) as needed.

ë Copy and paste information from the Internet to another program (like a
wordprocessor)
Highlight or select the text (or the web address)
Press Ctrl+C (Command+C on the MAC), Or Edit, Copy
Go to the other program (Word, WordPerfect, ClarisWorks, etc.)
Press Ctrl+V (Command+V on the MAC), Or Edit, Paste

ë Change the default page (home page)
Click on View, Internet Options.
Be sure you are viewing the General tab.
Under Home Page: type the URL of the page you want as your home page.
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Searching the Internet
Assignment: Try out at least 2 sites in each category below. 
This page is correlated to http://www.remc11.k12.mi.us/bcisd/classres/search.htm 

Four ways to search the Internet from Tom Snyder Productions training, www.teachtsp.com

1 Use Category Searches or Web Directories to browse through various categories (like a card
catalog in the library). Click on the heading topics to browse or surf through the information.
ë hierarchical: resources organized by topic and subtopic
ë fewer resources - not as overwhelming as getting thousands of returns from a search
ë resources collected and reviewed by people
ë annotations and reviews

Notes: 

2 Use Keyword Searches to find information (some of these also have category searches). Type in a
keyword and see what you find. It is best to start very specific and move to more general if that
doesn't find what you need.
ë most common way to search the Internet (can also be the most frustrating)
ë resources collected by computer programs called spiders or robots
ë have various rules for searching - read the help or tips - i.e. “put a phrase in quotes” to search

for the phrase in some search engines
Notes:

3 Use Specialized Search Engines and category lists that search only specific areas of information
(some of those below are paid resources)
ë scope is limited by factors such as topic, time, geography, or other factors
ë can be much more effective than a general search engine

Notes: OCLC FirstSearch requires an authorization number and password.

4 Use Compilations of Web Resources, Guides and Hot Lists compiled by other people 
ë other people, often other educators, have done the work
ë a great place to start

Notes:        
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Planning Research One: Organize Research
Ahead
Create a hotlist or a treasure hunt to guide students on the Internet.  This method requires the teacher to
find sites ahead of time.  The advantage is that teachers have more control over where students go on the
Internet.  It can be a less time consuming activity as well because the sites are already found and listed.

Bookmarks
Bookmark sites in Netscape.
Have students visit only bookmarked sites - if they are using the computer in your classroom.

Or Save the bookmark file and load the bookmarks on lab computers. (time-consuming)
Or Save the bookmark file and publish on the school’s web site.
Or Upload the bookmarks to http://www.backflip.com so you can access it anywhere.

HotLists idea from http://www.essdack.org/tips
1. Open a word processing document - preferably WordPerfect or Word.
2. Type the title of your hotlist page.
3. Insert a table (10 x 2).
4. In the left column enter the names of the web pages you want to link to.  You could also include the

questions for students to answer on that page.
5. In the right column, enter the URLs (addresses) of the web pages you want to link to.  Be sure to

press the space bar after the URL so that it hyperlinks automatically.
6. If your address didn't hyperlink automatically, highlight it, then click the Hyperlink Button.

Hotlist Option 1:
Students can use the Task Bar to move back and forth between MS Word and the browser.

Hotlist Option 2:
Save your document as a web page.
1. Word: Pull down the File menu to Save As HTML in Word

WordPerfect: or Internet Publisher; Publish to HTML. 
2. Create a new folder for the web pages.
3. Click Save. 

To view your web page through your browser:
1. Open your browser. 
2. Pull down the File menu to Open Page. 
3. Find your newly created page. 
Note - you may want to set this page as the home page in your browser's preferences. 
Or, save the file to disk and give it to your school’s webmaster to publish as your home page.
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BackFlip

What is BackFlip?
Backflip gets you back to the good stuff. It's the easiest way to save and share important things you see on
the Web. With Backflip's organization and powerful search, you'll never lose anything interesting again.
You can use it from any computer. And it's totally free. 

How does it work? 
As you discover interesting Web pages, use the Backflip it! button to save them and Backflip will organize
them for you. Then, simply go to your Backflip account and you'll find all of your favorite pages filed in
your personal directory -- which you can access from any computer.

Let's Explore! You may want to print this page to use as you work.

Open www.backflip.com
If you're interested in this FREE service, open an account and start saving your bookmarks to the world
wide web.
Click Start Here to sign up and get started! Follow the instructions online.

If you don't want to sign up right away, you could click on What is BackFlip and Take a Tour.

You should also explore SaveThis at www.savethis.com. It's another similar tool that seems to have more
versatility. At least Take the Tour!

Notes:
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Sample Treasure Hunt
This page is correlated with http://server.remc11.k12.mi.us/bcisd/classres/hunt.htm and created for
teachers.
1. Find 5-10 good reasons why you and your students need to use the Internet in the classroom.  (Then

use this list the next time a parent, teacher, or administrator asks about the benefits of the Net in an
educational setting.)

2. Find the email address of a teacher from another school district in Berrien County. Start at the BCISD
page and look for an applicable link. Teachers who don't have email accounts through
SouthwestNet/REMC/BCISD may have email from another service provider. 

 Try one of these services:
BigFoot: http://www.bigfoot.com The Switchboard http://www.switchboard.com/ 

3. Here's an activity appropriate for K-4 Internet challenges.  Find a favorite animal at one of these sites. 
Find answers for at least 3 of these questions.

! My favorite animal is: 
! It is an (circle one) amphibian, insect, arachnid, bird, mammal, reptile, other.
! It likes to live in areas such as
! My animal likes to eat
! It usually lives about this many years

3. Here's a couple geography questions appropriate for grades 6-10.
a. Name four former territories of the Soviet Union which have recently become independent

countries.  Which one has the largest population?
!
!
!
!

Hint: City.Net contains excellent up-to-date maps, and Altapedia has population information.

4. Here's a language arts activity.  Go to this site, find a way to write web tales, select a story title you
like, fill in the parts of speech, and print your story.  Staple it to this sheet.

5. Here's a geometry question for middle-high school students.  Find the name that matches the following
definitions.
! a portion of a circle
! two points determine this
! a triangle with two equal sides
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More Treasure Hunt Sample Questions
After reading the following articles, I decided to make another treasure hunt that was less fact-finding and
focused more on higher order thinking skills.

The Mind Candy Kafe http://www.fno.org/jun98/kafe.html
The New Plagiarism http://www.fno.org/may98/cov98may.html

The following questions and web sites can be found under Internet Activities at:
http://www.janinelim.com/1040window/

1. Visit Afghanistan Online and look under Culture. Look for the traditional instruments used in
Afghanistan. List them, then name the instrument group they fit into.

2. Visit Afghan Poetry and read the poem about the love of a nation. What can you learn about what
Afghanistan is like? Write a poem about your country/state/community that will give others an idea of
what it is like.

3. Visit Miftah Shamali - Algeria and look at the map. (There's a map at ArabNet - Algeria as well).
What area is pleasant in the summer? Why do you think that is?

4. Visit Azerbaijan International and scroll down to Topics. Choose Just for Kids and read the article
about Red. Name some reasons why red is the important color in Azerbaijan. If you were going to
choose a color for your country, what would it be? Write about why the color is important in your
country. Now read the article about Ali Jafar. What did you learn about people in Azerbaijan? What
do you like to draw? Draw a scene from the past like Ali Jafar likes to do. Write about someone you
know who does things well.

5. Visit Destination Bangladesh and look at the facts for the traveler. If you take $50 US dollars to
Bangladesh, how many taka will you get for your dollars? If you spend half your money on expensive
hotel rooms and half your money on expensive restaurant meals, how many nights can you stay? How
many meals can you eat?

6. Visit Bhutan - Atlapedia Online. What languages are spoken in Bhutan? What percent of the people
are literate? What challenges could this pose for the country?

There are more questions on the web site.
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What is Filamentality?
http://www.kn.pacbell.com/wired/fil/

What are the activity formats?

Hotlist

Scrapbook

Hunt

Sampler

WebQuest 

Starting A New Topic
7. Choose the ‘Start a new topic’ option from the home page to

begin your activity.  
8. Fill in the blanks.
9. Click on Spin this Thing!
10. Print the page so you remember the password.

Add Links
11. Click on Add Links at the bottom of the page.
12. Then use two browser windows & copy and paste to get the URLs (web addresses). Also write titles
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and descriptions. See
directions on next page.

Adding Links Cont.
13. First, open a new window to find your pages. File, New, Window.
14. Then find your page. (You may use a search engine, or you may have it already bookmarked.)
15. Then copy the web address:

drag across the "location" line to highlight the URL, then... 
do an Edit - Copy on the menu bar
then switch back to your Filamentality browser window (task bar or Window on the menu)
Then click the cursor into the URL box and do a paste ("Edit - Paste" from the menubar).

Repeat this for as many URLs/Web sites as you like.  If you want more than three, click on Add Links at
the bottom of the screen.

Saving
16. If you’re making a Hotlist, click on Hotlist to save. If you’re using another format, click on its name at

the bottom of the screen.

Customizing
17. Now the customization page comes up. Here you can edit the title and introductory paragraph of your

project. Edit at needed.

Post on the Web
18. To finalize your project and post it on the web, click on Hotlist at the bottom again!
19. Now you’ll be given the web address of your project. You should print this page as well or write

down the web address. You will give your students this address.

Filamentality’s Posting Policy
You have spent quite a bit of time planning your project.  It’s important that you understand the posting
policy for your project.  Your project can stay on the web for 12 months, during that time if you make
changes, you extend that time another 12 months.  This can be a good way to incorporate your web
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project into units that you do each year.  

Editing Your Project
20. When you want to edit your project, visit the Filamentality page, and this time click on Return to

Existing Topic.
21. Then scroll to the bottom. You can Add Links or Edit Links.
22. If you choose the same format you did before, you’ll be editing the title, introduction, etc.
23. You can also use the same web sites to make a new activity.
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Planning Research Two: Students Do
Own Research
This option requires careful planning and a definite structure for the activity.  Don’t let students loose on the
Internet to wander at will.  They will drift to their favorite sports pages, or worse, to inappropriate sites. 
There are ways to structure the assignment that can lessen this possibility.

1. Think carefully about the topic assigned or chosen for the research paper or project.

Fact finding vs. critical thinking/synthesis

2. Have students question.  Rather than gathering all information regarding the subject, form key
questions so that only pertinent information is retained. Questions should focus on big issues; begin
with why...? and how...? and should...? 
Read more on questions at: http://www.fno.org/sept96/questions.html

3. Keywords: use Inspiration or other tool to identify keywords related to your topic. Have students
come up with 20-30 keywords before touching a computer.

4. Other sources: Have students list books, magazines, journals, and other sources they can use before
going to the library. I would highly recommend that you assign a certain number of sources from the
Internet, and a certain number from print materials.

5. Use a research planner sheet to guide students planning.  Include this piece in your assessment. 
Require the sheet be completed before students go to the lab or library.

Notes:
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Research Planner Name                                          

My Topic:

My Big Questions : (Why, How, Should...)

20 - 30 Keywords : (List synonyms too.) 

Keyword Combinations : (for more specific searching)

Search Engines and Sites I Plan to Search

Books, Magazines, and Encyclopedias I Can Search

During Your Search: Are your search results close? At least some of the first 10 items returned should be
about your topic.  If not, try different keywords or a different search engine.
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During Research Process
ideas from http://www.essdack.org/tips

Collecting Information:
Copying Text from the Internet
1. Highlight (click and drag across) the desired text.
2. Pull down the Edit menu to Copy.
3. Move to your word processing document.
4. Pull down the Edit menu to Paste.

Copying Images from the Internet (Mac only)
1. Center your cursor over the image you want to copy.
2. Click and hold the mouse button. A pop-up menu should appear.
3. Choose to Copy the Image.
4. Move to your word processing document.
5. Pull down the Edit menu to Paste.

Saving Images, Movies, Sound, and Animations from the Internet
1. Center your curser over the movie or animation you want to copy.
2. Click and hold the mouse button (right button for PC's). A pop-up menu should appear.
3. Choose to Save the Image (or whatever it is).
4. Save the object to your hard drive.
5. Go to your word processing document or other kind of program (i.e. PowerPoint)
6. Insert the movie or animation using the program's directions. (File – Insert)

Keeping Track of Internet Resources
Option One: A Table in Word
ë Open a wordprocessing document.
ë Change the page layout to Landscape (horizontal).
ë Click and drag the Table icon to create a table that is 10 x 5.
ë Enter the following in the top row: Item, Date, Author, Title, URL (or Address)
ë As you harvest information from the Internet, enter the information in the appropriate cells.
ë Insert additional rows as needed.
Note - It is easiest to copy and paste the URL.

Item Date Author Title URL

article about
research

downloaded:
1/25/99
published:
Vol 7|No
8|May|1998

Jamie
McKenzie

The New Plagiarism:
Seven Antidotes to
Prevent Highway
Robbery in an Electronic
Age

http://www.fno.org/may98/
cov98may.html
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Keeping Track of Internet Resources
Option Two: A Database (this could be done with a table too)

idea and quote from http://www.fno.org/may98/cov98may.html

The database could be set up like this:

Source (Author, Title, Date, URL)

Subject:

Keywords:

Abstract:

“Subject Words: It pays to teach your students how to develop a relatively brief list of subject words
drawn from their cluster diagram. In order to show them the power of a well constructed database, you
should give them a chance to explore the searching capabilities of one you have constructed. Show them
how subject words support the sorting and sifting which will later help them make meaning of their findings.

Keywords: Demonstrate for your students that keywords offer a greater level of detail and work at the
sub category level below subject words. 

Abstract: The abstract is where students save pertinent information. We must teach them to paraphrase
and condense, avoiding the cutting and pasting of huge (often unread) blocks of text.”

Green Ink: Have students write their own thoughts and opinions in another color.

Example:  from http://www.fno.org/may98/cov98may.html

Source (Author, Title, Date, URL) May, 1998, From Now On, Jamie McKenzie, "The New
Plagiarism: Seven Antidotes to Prevent Highway Robbery in an Electronic Age."
http://fno.org/may98/cov98may.html 

Subject: research, plagiarism, strategies

Keywords: incentives, rewards

Abstract: McKenzie suggests the use of green ink to help student differentiate between the ideas
they have collected and the new ideas they have built in reaction to those inspirations. 

With this option, use the wordprocessor’s Edit--Find feature to find articles or keywords.
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Exploring New Resources
Assignment: Explore the Classroom
Resources page for useful sites and resources
for your own use and for your classroom.

Summer Sites (Or whatever the month
happens to be).  This link takes you to a list
of sites appropriate for holidays and other
activities during the season or month.

The Blue Column is often updated and
includes sites on recent issues, really neat
sites I’ve found, or interesting projects.

Content Areas Sites are also listed by content area.  Most of these pages have only one page per content
area.  Science is an exception.  There are so many science sites that I’ve organized them by the Michigan
Content Standards. So there are four pages: General, earth, life, and physical science. Social Studies has
two pages - one called social studies and the other for multicultural and world sites.

Web Cam, Audio, and Video are lists of sites that include multimedia.  Interesting options here for
supplementing a class.

Notes:
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Evaluating Web Sites
“Becoming an Info-tective
1. Who provided this information?  Why?
2. Is someone trying to sell us a product or point of view?
3. How is the source coded (e.g. “.com” = commercial; “.gov” = government; ... etc.)? How might this

influence our evaluation of its accuracy?  Can we assume that everything from an educational
institution, for example, is necessarily true?  How about from a government source?

4. What possible biases may be detected here? ...
5. If quotes or data are provided, are they appropriately referenced?
6. How can we find other information with which to compare and evaluate accuracy (e.g. call sources,

check authorized print sources)?
7. Does this information represent theory or evidence? What is the difference between these terms? How

can we distinguish one from another? ...
8. Why might some sources be more accurate than others (e.g., many professional journals are reviewed

by experts before publication)?
9. How do the visuals influence the way we receive this information? Is emotion a part of the design? Are

sound effects intended to influence our thinking?
10. Do the visuals and the text convey the same message?”

Healy, J. M. (1998). Failure to connect. Electronic School, 185(9), A42. 
See also http://www.electronic-school.com/

Other articles to read:
Kathy Schrock’s Guide for Critical Evaluation Information

http://discoveryschool.com/schrockguide/eval.html
Evaluating Educational Web Sites

http://oii.org/archives/evaluate.html
Evaluating Internet Based Information

http://www.lme.mankato.msus.edu/class/629/Cred.HTML

Bogus Sites to Teach Evaluation
Ban Dihydrogen Monoxide

http://www.lme.mankato.msus.edu/class/629/dhmo.html
Tass.net

http://www.tass.net/
Librarian as an Integration Partner: Scroll down to the section on Evaluation Sites

http://www.kalama.com/~zimba/integration.htm

Notes:



Evaluation Criteria
Traditionally, we focus on evaluating what we read and watch. The same principles of evaluation apply for
books, media, and the Internet.

1. Accuracy
Remember! Anyone can publish anything on the web. No editor needed.
Does the information seem to be right?
Are there a lot of mistakes in the site?
Are the sources listed, if appropriate?
Are graphs and charts clearly labeled?
Is there any indication the site has been tampered with?

Phil 4:8 Finally brethren, whatsoever things are true... think on these things.
Proverbs 23:23 Buy the truth, and do not sell it, also wisdom and instruction and understanding.

2. Authority
Can you figure out who the author or editor of the site is?
Who are they and why are they writing about this topic?
Are they sponsored by an organization or paying for it themselves?
Do they have any qualifications to write about this topic?
Is there a way to contact the person responsible for the site?

John 12:49 For I have not spoken on My own authority; but the Father who sent Me gave Me a
command, what I should say and what I should speak. (Jesus spoke with authority, but not His
own, the Father's authority. This gave Him credibility.)

3. Objectivity
Remember! The web can be anyone's soapbox!
Is the information full of opinions or is it mostly facts?
Is the webmaster trying to sway your opinion?
Is the site provided as a public service?
Is the advertising clear? Does it get in the way of the information?
Are editorial comments labeled or obvious?
Whose point of view is the information from?

Phil 4:8 whatsoever things are just, whatsoever things are of good report....think on these things.

4. Currency
Is the information on the site up-to-date?
Is the date on the site? Is it today's date, the posting date, or the revision date?
Has it been updated recently?
Are the links still current?



5. Coverage
Is this the full text of the material or a summary?
Are you getting the whole thing or are additional plugins or software necessary?
Links within a site that extend the information must be evaluated separately unless they are a part of the
same site.
Are the links appropriate for the site?
Is the site complete or under construction?

Philippians 1:6 being confident of this very thing, that He who has begun a good work in you will
complete it until the day of Jesus Christ.

It is important to decide the purpose of a web site.  There are several different types you will encounter
when using the Internet for research purposes.

News page: purpose - usually to provide current information
examples: USA Today, CNN, New York Times, Time, US News, etc.
When using these sites, remember you may be getting articles by different authors.  You will need a
bibliographic entry for each article you use.  Not just the main site.  It is just like using a newspaper or
magazine.

Advocacy page: purpose - to influence public opinion
examples: National Rifle Association, National Right to Life Committee, various political parties, etc.
When using these sites, try to find out if it is the “official page” or approved by the organization. 
Remember their purpose is to sway your opinion to their viewpoint!

Informational page: purpose - to present factual information
examples: Volcano World, National Geographic, dictionaries, calendars, etc.
Most of the pages you find will probably fall into this category.  Sometimes Information pages overlap
into News pages.  Again, remember you may be getting articles by different authors.  You will need a
bibliographic entry for each article you use.  Not just the website.  It is just like using a newspaper or
magazine.

Other types you may encounter include:
Entertainment, business, and personal. If you use any of these types in your project, be sure to
evaluate them carefully. 

Notes:

-This information was adapted from a presentation handout from a workshop titled: Cybrarians: Media
Specialists and the Internet. Presented at the Connected Classroom Conference, November 1997, by
Patti Tjomsland
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Citing Internet Resources
Documenting Electronic Resources
Purdue University Writing Lab. Using MLA Format. 1998. April 20, 1999.

<http://owl.english.purdue.edu/Files/33.html>.

A web page
     Author(s). Name of Page. Date of Posting/Revision. Date of Access. <electronic address>.

N.B. It is necessary to list your date of access because web postings are often updated, and information
available at one date may no longer be available later. Be sure to include the complete address for the site.
Also, note the use of angled brackets around the electronic address; MLA requires them for clarity.

An article in an online journal or magazine
Author(s). "Title of Article." Title of Journal Volume. Issue (Year): Pages/Paragraphs. Date of Access
<electronic address>.

N.B. Some electronic journals and magazines provide paragraph or page numbers; include them if available.
This format is also appropriate to online magazines; as with a print version, you should provide a complete
publication date rather than volume and issue number.

Email
Author. Email to the author. Date.

A listserv posting
Author. "Title of Posting." Online posting. Date. Name of  listserv. Date of access <electronic address
for retrieval>.

Notes:
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Collaborative Internet Projects
Levels of Access
No computer in the classroom/Internet access at home
 u Email projects with other schools - you collect the email, print, and distribute it to students, then

type in their answers (or have them type their messages in a text editor and copy and take it home
to send)

One computer in the classroom with Internet access in the classroom, at home,  or in school library
 u Students check email and/or newsgroups or email a question to an expert at Ask-An- Expert
 u Use offline browser software like WebWhacker to help you get project web pages available on

computers without Internet access.
 u Participate in online projects

Three+computers  in the classroom or lab with Internet access (use groups/pairs)
 u Students create web pages of information about their classroom, school, projects, writing, and

others.
 u Students visit sites to gather information for Internet scavenger hunts or other teacher-directed

activities.  Most lessons can take students to just a few Web sites to find all the information
necessary.

Project Sites
Here are some ways to find out about projects:

Project Pages
http://www.remc11.k12.mi.us/bcisd/classres/projtrip.htm

Global SchoolNet Internet Project Registry
http://www.gsn.org/pr/

Houghton Mifflin’s Project Center
http://www.eduplace.com/projects/

AVLN Projects
http://www.avln.org/
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Planning to Participate in an Internet Project
Decide whether you want to do penpals or a content oriented project.

PenPals
11. Find a classroom that has similar access as you do and is about the same grade level.

12. Decide who will write the email.  You could do it as the teacher, or have the student type the
messages in a word processor and cut and paste them into your email.  Or have the students write it
out and you type it up later in the email.

13. Think of some questions and topic areas you want to discuss and write about.  Then go for it!

Content Related Projects
1. Decide what theme or content area you’d like to cover with a project.  Look through projects.  (My

favorites are Houghton Mifflin’s Project Watch and the Project Registry from Global School Net).

2. Find a project that matches your curriculum goals and grade level.  Don’t just do a project because it
looks fun.  Ask yourself how it will enhance or improve student learning in that area.

3. Look at the activities of the project and be sure you can do them with the access available at your
school.

4. Decide what pre-teaching you’ll need to do.  Plan for other non-computer activities that relate to the
theme and tie to your curriculum.  Create a schedule with time for the activities included in the project.

All Projects
When you finish, evaluate how it went.  How did it enhance student learning?  What problems did you
encounter?  How can you plan for and solve them next time?  What project will you do next?
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Internet Project Planning Worksheet
PenPals
What classroom will you participate with?

How will you do the writing?  Include how you will connect, how often you will write, what software you
will need, etc.

What questions and topic areas do you want to discuss?

Content Related Projects
Decide what theme or content area you’d like to cover with a project. 

Find a project that matches your curriculum goals and grade level.  How will this enhance or improve
student learning?

What type of Internet access is required for this project?  Do you have that available? What else would
you need to get and/or learn?

Decide what pre-teaching you’ll need to do.  Plan for other non-computer activities that relate to the theme
and tie to your curriculum.  Create a schedule with time for the activities included in the project.

All Projects
How did it enhance student learning?  What problems did you encounter?  How can you plan for and
solve them next time?  What project will you do next?
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